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Welcome 
Thank you for purchasing a DeckLink broadcast 
video card. We hope you share our dream for 
the television industry to become a truly creative 
industry by allowing anyone to have access to the 
highest quality video.

Previously high end television and post production 
required investment in millions of dollars of 
hardware, however with DeckLink cards, even 10 

bit uncompressed is now easily affordable. We hope you get years of use from 
your new DeckLink card and have fun working with some of the world’s hottest 
television and design software!

This instruction manual should contain all the information you’ll need on 
installing your DeckLink capture card, although it’s always a good idea to ask 
a technical assistant for help if you have not installed hardware cards into 
computers before. As DeckLink uses uncompressed video and the data rates 
are quite high, you’ll need fast storage and a high performance host computer. 

We think it should take you approximately 15 minutes to complete installation. 
Please check our web site at www.blackmagic-design.com and click the 
support page to download the latest updates to this manual and DeckLink 
driver software.

Lastly, please email us (register@blackmagic-design.com) with your DeckLink 
serial number so we can keep you updated when new software is released. 
Perhaps you can even send us your latest show reel of work completed on 
your DeckLink!

We are constantly working on new features and improvements, so we would 
love to hear from you! 

Grant Petty
CEO Blackmagic Design
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Storage and data rates for 
uncompressed video
The data rates for uncompressed video are quite high, and listed below are 
minimum recommended disk requirements for uncompressed standard 
definition and high definition video. 

Uncompressed 10 bit YUV (4:2:2)
Standard Definition
Frame Size  MB per second MB per minute  GB per hour
720x486/29.97fps 27  1 600  94
720x576/25fps  26  1 582  93

High Definition 
Frame Size  MB per second MB per minute  GB per hour
1280x720p/60fps 141  8 438  494
1920x1080/24PsF 127  7 594  445 
1920x1080/50i  132  7 910  463
1920x1080/60i  158  9 482  556

Uncompressed 10 bit RGB (4:4:4)
High Definition 
Frame Size  MB per second MB per minute  GB per hour
1280x720p/60fps 211  12 656  742
1920x1080/24PsF 190  11 391  667
1920x1080/50i  198  11 865  695
1920x1080/60i  237  14 238  834

Due to disk seeks, when calculating the data rates required for your disk 
system, it is a good idea to add a safety margin due to fluctuations in disk 
speed. The degree of margin can be reduced by adding more disks. 

Serial ATA (SATA) disks can reduce to half their speed as they become full, so 
in a 2-disk SATA array you should aim for a 100% safety margin. In an 8-disk 
SATA array, a 30% safety margin should be adequate. SCSI disk arrays seem 
to display less fluctuation and so a 20% safety margin should be adequate for 
an 8-disk SCSI array. Generally the more disks in the array, the better.

Note: Although other vendors and third parties may provide different data rates 
for uncompressed video, the above recommendations are tested for use with 
Decklink cards. 
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Standard Definition on Windows™ 
Minimum system requirements
Operating System
Microsoft Windows XP® Pro with service pack 1 or later
[Microsoft Windows 2000® and Server 2003 are not supported]

Hardware
Processor
• Intel Dual Xeon 2.8GHz or higher for Intel 7505/7525 chipset based systems
• Intel Pentium 4 3.0 GHz or higher for Intel 875p chipset with 800MHz FSB

Motherboard
• Intel 7505/7525/875p chipsets – These include motherboards such as  
   Supermicro X5DAE, X5DA8, X6DA8-G2 and P4SCT+II

PCI slots
• 64 bit PCI 33/66 MHz or PCI-X slots 100/133MHz

Memory
• 2 GB ECC 2100 RAM or DDR 400/333/266 SDRAM for 875p chipsets

Graphics card
• AGP x 8 Graphics card (Not Matrox)
• PCI E x 16 (Nvidia FX1300)

Disk Arrays
• SCSI - Ultra 160 or Ultra 320 SCSI card (either PCI or onboard); with at least  
   2 x U160 or U320 SCSI disks, 10 000 rpm, software striped as RAID [0], OR;
• SATA - SATA RAID card  (either PCI or onboard); with at least 2 x SATA disks,  
  10 000 rpm, software striped as RAID [0].

Note: If using Intel 875p chipsets, make sure that the motherboard has 64 bit 
PCI slots. 32 bit PCI slots are not recommended or supported.

Standard Definition Monitoring
For monitoring Standard Definition and High Definition video, check out 
Blackmagic Design’s low cost HDLink. HDLink converts your SD and  
HD-SDI output to DVI-D, perfect for use with LCD displays such as the  
Apple HD Cinema™ 23” display. HDLink features 2 x resize of NTSC and  
PAL on 1920x1200 pixel displays and also provides analog RCA audio output. 

For more information on HDLink visit www.blackmagic-design.com

DeckLink™ DeckLink Pro™

DeckLink SP™ DeckLink Extreme™
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DeckLink HD™ DeckLink HD Pro™

5 High Definition on Windows™  
Minimum system requirements
Operating System
Microsoft Windows XP® Pro with service pack 1 or later
[Microsoft Windows 2000® and Server 2003 are not supported]

Hardware
Processor
• Intel Dual Xeon 2.8GHz or higher

Motherboard
• Intel 7505/7525 chipset – This includes motherboards such as Supermicro 
   X5DAE, X5DA8 and X6DA8 - G2

PCI slots
• 64 bit PCI-X slots 100MHz and 133MHz

Memory
• 2 GB ECC 2100 RAM 

Graphics card
• AGP x 8 Graphics card (Not Matrox)
• PCI E x 16 (Nvidia FX1300)

Disk Arrays
• SCSI - Ultra 320 SCSI card (either PCI or onboard), with at least  
   8 x U320 SCSI disks, 10 000 rpm, software striped as RAID [0], OR;
• 2GB fibre Channel
• SCSI card recommendation - Adaptec 39320 series

Note: Check the Blackmagic Design website for updates on hardware 
compatibility at www.blackmagic-design.com and “click on the support page.” 

High Definition and Standard Definition Monitoring
For monitoring high definition and standard definition video, check out 
Blackmagic Design’s low cost HDLink. HDLink converts your HD and  
SD-SDI output to DVI-D, perfect for use with LCD displays such as the  
Apple HD Cinema™ 23” display. HDLink features 2 x resize of NTSC and  
PAL on 1920x1200 pixel displays and also provides analog RCA audio output. 

For more information on HDLink visit www.blackmagic-design.com
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Hardware installation
1. Remove the power plug from the back of your PC.  This is a safety 

precaution before opening your computer. Ensure that you are statically 
discharged by using a static strap.

2. Remove the side cover of your PC to gain access to the PCI slots.

3. Remove your DeckLink card from the protective static bag making sure 
you don’t touch the gold connectors on the base of the card. These 
precautions should be taken when handling any PCI card.

4. Find a spare PCI or PCI-X slot (DeckLink HD series cards require a PCI-
X slot). Remove the metal port access cover, and screw, from the back 
of your PC.

5. Insert your DeckLink card and ensure that it clicks into place.

6. Secure the card by the screw or clamping device.

7. The procedure for installing a RAID controller card is similar to the 
above (The RAID controller card should be installed into a 100MHz PCI-
X slot.)

8. Now replace the side cover of your PC. Reconnect the power and start 
up the computer.

Note: If installing DeckLink HD or DeckLink HD Pro make sure you use the 
133MHz PCI-X slot.
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Blackmagic DeckLink Software
The Blackmagic Design software installer supports standard and high definition 
video formats and all Blackmagic Design DeckLink PCI cards. 

The Blackmagic DeckLink software installer will install the following components.

1. Blackmagic DeckLink drivers.

2. Blackmagic Deck Control application (for QuickTime™).

3. Blackmagic DeckLink control panel.

4. Blackmagic QuickTime™ codecs.

5. Adobe Premiere Pro® plug-ins and presets.

6. DirectShow™ filter for capture, playback and conversion.

7. Blackmagic Disk Speed Test.

Note: Before installing any software or hardware you will need administrator 
privileges. 
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Pre-installation checks
SCSI Devices 
Some SCSI cards/onboard controllers have their own utilities. Adaptec SCSI 
cards have a utility that can be accessed before the BIOS starts up when 
powering on your PC. Use “control A” to access SCSI utilities.

If you intend to run your disk array as a software stripe you will need to make 
sure that ‘host RAID’ is disabled. Use the “Disk Management” tool in “Computer 
Management” within Windows XP™ to set up your software RAID, or refer to 
third party instructions when using pre-configured hardware RAIDs.
Onboard SCSI controllers can also be used.

QuickTime™ 
Make sure the latest version of QuickTime™ is installed on your PC. 
QuickTime™ can be found at www.apple.com/quicktime 

Software Applications 
DeckLink cards work with applications such as Adobe Premiere Pro®, 
Adobe After Effects® and Discreet Combustion™. The DeckLink installler will 
install components into some of these applications. If you install or update 
these  applications after installing your DeckLink card, you should reinstall the 
DeckLink drivers to ensure these applications will work with your DeckLink card. 
Having software applications pre-installed will simplify the installation of your 
DeckLink card. 
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Installing Blackmagic DeckLink software

1. When the Windows XP™ desktop loads, the Windows hardware 
wizard will automatically appear. Click on  “cancel.” 

2. The CD supplied with the DeckLink card contains the Blackmagic 
installer. In order to ensure that you have the very latest driver please 
visit www.blackmagic-design.com and click on the support page. 
Note: Should the installer on the website be a newer version than 
the one on your installer CD, download and save the zip file for future 
installations.

3. Go to the location of the downloaded installer and double click the self 
extracting zip file.

4. Now double click on the DeckLink Installer. All DeckLink cards use the 
same installer.

5. The drivers will now be installed on your system. A warning will appear 
that “this software has not passed logo certification to run on Windows 
XP.” Click “continue” and ignore this warning. 

7. You will see a dialog bubble saying “found new hardware”, and the 
hardware wizard will appear. Select “install automatically” and the 
system will find the required DeckLink drivers. You will then receive 
another dialog bubble saying “your new hardware is ready for use.”

6. Now restart your machine to enable the new software drivers.

Note: Keep the installer handy, as it has the added feature of being able to 
“repair” or ‘‘remove” the driver if required.
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8. Now restart your machine to enable the new software drivers.

9. To check the installation has been successful, right click on “my 
computer” –> manage -> device manager -> display adaptors. 
There should be two display adaptors. One will be your AGP card such 
as NVIDIA or ATI, and the other will be your DeckLink card. 

10. When updating to the latest Blackmagic drivers “uninstall” the current 
version you are using. You can do this from control panels -> add or 
remove software -> Blackmagic DeckLink -> remove. Then run 
the latest installer.

11. Select where sound is routed when playing and capturing QuickTime™ 
movies.  Open the QuickTime™ control panel, pop up the “Sound 
Out” menu and choose SDI Digital Audio. Switch the pop up menu 
to “Sound In” and choose SDI Digital Audio. The settings should be 
48 kHz, Stereo and 16 bits. SDI Digital Audio” should be chosen 
even when using analog audio with cards such as DeckLink SP and 
DeckLink Extreme. Analog convertors on the analog DeckLink cards 
ensure the audio is converted to and from analog or digital as required.

Important Note
Viruses are an ever-increasing problem on computers. Computers will often 
slow down if they become infected. This can cause various problems in video, 
especially dropped frames and stuttering audio. For this reason, we recommend 
you dedicate your PC to video work and avoid using it for other tasks which 
may introduce viruses, e.g. email, web browsing and sharing of ejectable disks 
such as USB disks and non-commercial CD’s & DVD’s.

It is good practice to run antivirus software and keep it up to date. However, 
the memory-resident component of many antivirus products is likely to cause 
your video to drop frames. Accordingly, we recommend disabling the memory-
resident component of your antivirus software while performing any video or 
audio work. Most antivirus programs show an icon in the Windows Taskbar 
and clicking (or right-clicking) on this icon will usually reveal an option to disable 
automatic virus protection. Disable the automatic protection (“memory resident 
protection”) while working on video or audio.

If you are also going to use your PC for purposes other than video or audio 
work, it would be wise to re-enable the automatic virus protection whenever you 
have finished your video and audio work. 

10



Blackmagic Design - Leading the creative video revolution™

Windows XP™

Getting Connected: Display Settings

1.   After completing the software and hardware installation, connect your 
DeckLink card to an external device such as a broadcast monitor, tape 
deck or Blackmagic HDLink. Connection diagrams, for the DeckLink 
family of cards, can be found towards the end of this manual from page 
21 onwards.

2.   Go to Control Panels -> Displays and click on the Settings tab. 
Select the DeckLink display which is shown as “Display 2” in the 
accompanying screenshot of the “Display Properties.” In this diagram, 
the Screen Resolution is set to 720 x 486 which is the setting for 
NTSC. If you need to switch to PAL or a HDTV resolution, click on the 
“Advanced” button.

3.   When the new window opens, click on the Adapter tab and it should 
list “Blackmagic DeckLink Display” for the Adapter Type. Click the “List 
All Modes” button shown in the Default Monitor screenshot.

4.   The “List All Modes” window will show you all of the modes supported 
by your model of DeckLink card. The standard definition DeckLink 
cards will list two modes, NTSC (720 x 486, 29 Hz) and PAL (720 x 
576, 25 Hz), as shown in the screenshot. The high definition DeckLink 
cards will list many more modes. 

  Select the desired mode and then click OK. In the Default Monitor 
window, click “Apply.”

Note: DeckLink HD cards can display only 720x486 or 720x576 in 
desktop mode.
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5.   A message will appear requesting that you confirm this change to 
the resolution. If your broadcast monitor appears to show the correct 
resolution, click the “Yes” button. Then click the “OK” button in both 
the Default Monitor window and finally in the Display Properties 
window.

  Note: There is an easier method for switching between HDTV 
resolutions. Just use the Screen Resolution slider in the Display 
Properties windows to move between resolutions. Unfortunately the 
Screen Resolution slider cannot be used to switch to NTSC or PAL as 
Windows XP hides resolutions below a certain size. That is why the 
“List All Modes” window must be used to switch to standard definition 
resolutions.

6. The SDI and analog outputs are always active on DeckLink cards.  
If you need to switch the analog connections between composite and 
component, use the DeckLink control panel located in “Control Panels.” 
You can adjust your analog settings in the video tab of the DeckLink 
control panel.

Note: When using the DeckLink HD Pro video output in RGB 4:4:4 Dual Link 
mode, the signal from the analog component outputs will be RGB, so switch 
your broadcast monitor to RGB. You can still playback 8 and 10 bit YUV files, as 
this setting only effects the video output setting. DeckLink HD Pro will translate 
these files to RGB on playback in real time.
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Analog Video Input Processor Amplifier
We now include a Proc Amp tab in the DeckLink control panel.

Proc Amp can be used to adjust gain level controls for any cards with analog 
input, i.e. the DeckLink SP and DeckLink Extreme. We have decided to add this 
control due to variations in video output from analog tape decks.

This is also a reason why SDI is preferable to analog video, as it does not 
suffer from the potential gain variance issues which can be seen with analog 
components.

Preserving Blanking Data or VANC
To preserve VANC data when capturing, this can be enabled in the DeckLink 
control panel. Now you can use up to 3 video lines at the top of a captured 
QuickTime™ (Mac & Windows) or AVI (Windows only) movie file to store any 3 
lines from vertical blanking. This allows 3 line timecode, VITC, vertical interval 
test signals, subtitle info or any other VANC data to be preserved between 
capture and playback. Software applications can also access these lines if 
required.

This uses standard QuickTime™ and AVI files, so applications such as After 
Effects® and Premiere Pro® will be compatible. This works on all standard or 
high definition DeckLink cards. You can select if you want 1, 2 or 3 lines to be 
used.

Although an extra metadata track to the QuickTimeTM/AVI file would be 
desirable, it would not be compatible with some video applications. We also 
thought about making the movie file 3 lines larger in the vertical resolution. 
So for example, 1080 would become 1083. However these files would be 
incompatible with normal files so it is not a good solution. So we thought that 
most people don’t miss a line or two from the top of the image and it would be 
beneficial to include this feature and use a line or 2 or 3 for that blanking data 
storage.

The great advantage is we don’t need to know about the data structure of the 
VANC data, as we just capture the lines. So if there is some special data that 
you want to use, that’s no problem, as we just capture the lines intact, put them 
in the top lines of the movie file. We then put the lines back into the vertical 
blanking when playing back the files.
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Because these lines can be passed to the application, a developer could write 
software to read the VANC data and use it for various purposes, e.g. 3-line 
timecode and audio chasing, or other uses. This feature has unlimited uses!

You can use this feature with software, such as Deck Emulator software, to 
create a disk recorder that captures and preserves on playback 3-line timecode 
in telecine suites etc.

How the VANC Feature Works?
This feature allows you to preserve lines of VANC in the vertical blanking and 
store them into lines 1 to 3 of the video file. These lines are then inserted back 
into the video blanking when the file is played back.

You can select to hide these lines from the application so they don’t look ugly, 
or to let them be passed to the application if you are running software that 
interprets this data.

An example of VANC data is 3-line timecode, which uses lines 18, 19, and 20 
in NTSC or lines 19, 20 and 21 in PAL. 3-line timecode, as used in AATON™ 
equipped telecine suites, feature audio timecode and keycode information along 
with the normal timecode numbers.

Genlock
Genlock, also known as black burst or house sync is used to lock different 
pieces of equipment to the same timing throughout a facility. When two or more 
video devices are connected to the same sync signal, their video signals can be 
switched without jumping or rolling. This is critical when more than two devices 
are connected at the same time.

DeckLink and DeckLink HD cards are designed for direct connection to video 
decks, and as such, do not have genlock connections. When using these or 
any other Decklink cards directly with a deck, the deck can be synced to the 
video signal coming from the Decklink card. The Blackmagic Decklink System 
Preferences can set to provide a stable black signal to the deck during capture 
operations, as found in Control Panels in Windows™. 

All other SD DeckLink cards can be connected to standard bi level sync for 
genlock. This standard composite video signal needs to be stable, which is why 
we recommend a specific signal generator like a blackburst generator. All other 
HD DeckLink cards need to be connected to tri level sync when in HD mode, 
to correctly lock. If these cards are running in SD mode then a standard bi level 
sync can be used.
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Blackmagic Deck Control
Blackmagic Deck Control is a basic utlity used for capture from, and recording 
to your tape deck. It is controlled via RS-422 and uses the Sony™ RS-422 
protocol. 

It is designed to be used in conjunction with applications such as Adobe After 
Effects® and Discreet Combustion™, which do not include their own deck 
control capabilities.  

Pixel formats supported by Blackmagic Deck Control are:  
 Blackmagic QuickTime™ R210 (10 bit uncompressed 4:4:4 RGB)
 Blackmagic QuickTime™ v210 (10 bit uncompressed)
 Blackmagic QuickTime™ (8 bit uncompressed)
 Blackmagic QuickTime™ PhotoJPEG (compressed)

This utility can capture or playback one video clip at a time. The application 
windows, of which there are two, are used for viewing clips and deck control. 
The left window is the clip playback window and the right is the capture/deck 
window.

NOTE: Deck Control does not currently support AVI files, so you should not use 
it for capture when working with applications such as Adobe Premere Pro™

Setting Up

1. Double click the Deck Control icon on your desktop to open the 
application.

2. Open edit -> preferences. Select one of the Easy Setups from the drop 
down menu.

3. Select your disk array as the capture location.

4. Click “OK.”

5. Select File-> open, and choose the video file you wish to playback. The 
file will appear in the playback window. Click the “play” triangle below 
the clip. You can also scrub the clip just like the QuickTime™ player.

Note: Make sure the files you wish to play back are TV-formatted QuickTime™ 
files. If they’re not QuickTime™ files, you’ll not see your clip on the DeckLink 
output. Deck Control will not playback AVI files but this is planned for a future 
update.
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Deck Control features
 Loop playback
 Loop back and forth
 Grab frame (to Photoshop™ file)
 Copy and paste (just like QuickTime™ player)

Inserting to Tape

1. Open the clip that you require to print to tape.
2. Enter the timecode of the desired in-point.
3. Click “Put clip.”

Capturing Clips

There are two ways to capture clips.
1. Capture now – captures video and audio instantly.  
 Short cut: Control K.

2. Get clip – captures frame accurate timecode, video, audio to “in” and 
“out-points” set by the user. [Timecode will only be available if RS-422 
is connected]
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Blackmagic LiveKey
[Standard Definition Only]
Video and Key output support is included with the DeckLink Pro capture 
card. 

You can output the key and fill channel using DeckLink Pro with a down-stream 
keyer/mixer for use in ‘live events’ and broadcast graphics. 

DeckLink (i and ii), DeckLink Pro, DeckLink SP and DeckLink Extreme 
cards also feature internal keyers. This means you can key inside the card 
and dub video through the card with keyed graphics over the top. Blackmagic 
LiveKey also features ‘fade up and down’ of the graphic automatically.

Blackmagic LiveKey lets you enable these modes and when you quit this 
application, the card will return to a normal video operation. Because you can 
dub from your broadcast deck to VHS via the DeckLink Pro, DeckLink SP and 
DeckLink Extreme cards, you can finish a master, and then using Blackmagic 
LiveKey add a company logo or bug to your show reel dubs.

As Blackmagic LiveKey is used in environments where the keyed picture is 
broadcast to air or for live events; once launched, Blackmagic LiveKey will 
dominate the output of the Decklink card. This means that even if Blackmagic 
LiveKey is in the background and another application is in use, the video output 
will be stable and reliable. 

NOTE: When Blackmagic LiveKey is in use, you won’t be able to open any other 
software application that needs to control the Decklink card, such as your NLE 
or compositing software.
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Hardware Down-Conversion with 
DeckLink HD Pro
Simply go to control panels -> decklink and choose the down conversion you 
require. It can be switched between 4:3 letterbox or 16:9 anamorphic.

Link A output will be the SD and Link B output will always be HD.  The 
outputs are simultaneous and the downconversion is broadcast quality.

Note: For desktop down-conversion make sure that the desktop is set to 
either 29 hertz or 25 hertz. Down conversion is not currently available for 
23.98 or 24PsF

Note: Down-conversion is not available if in Dual Link 4:4:4 mode.

Switching to 4:4:4 mode with DeckLink 
HD Pro
Go to control panels ->decklink select the dual link RGB 4:4:4 checkbox
Your card is now in 4:4:4 mode and can be used with programs such as 
Premiere Pro and After Effects for full 10 bit HD 4:4:4 editing and effects 
work.
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Adobe After Effects®

Minimal configuration is required for Adobe After Effects®.

Simply, open the application and select the television standard frame size and 
frame rate you wish to work with.

How to use your DeckLink Card as a Frame Buffer
To allow your Adobe After Effects® composition to be displayed in real-time 
from your DeckLink card, go to edit->preferences->video preview. Select 
Blackmagic RGB and the appropriate video standard. Now you can view your 
Adobe After Effects® compositions in YUV colorspace on your broadcast 
monitor as well as your desktop. No more nasty surprises when you go to air 
or tape - what you see is what you get!

Rendering
When you have completed your composition, you will need to render to a pixel 
format supported by Blackmagic DeckLink. 

Below is a list of supported codecs:
 Blackmagic QuickTime™ R210 (10 bit uncompressed 4:4:4 RGB)
 Blackmagic QuickTime™ V210 (10 bit uncompressed)
 Blackmagic QuickTime™ (8 bit uncompressed)
 Blackmagic QuickTime™ PhotoJPEG (compressed)
 Video for Windows™ (8 bit uncompressed AVI)
 Video for Windows™ (10 bit uncompressed AVI)
 Video for Windows™ R210 (10 bit uncompressed 4:4:4 RGB AVI)

For all HD standards, select upper field first.
For NTSC 720 x 486, select lower field first.
For PAL 720 x 576, select upper field first.

Supported file formats in Premiere Pro™
RGBA (RGB + Alpha) Video for Windows (None)
Blackmagic QuickTime™ 8 bit and 10 bit uncompressed
Blackmagic 8 bit and 10 bit uncompressed AVI
Blackmagic QuickTime™ R210 (10 bit uncompressed 4:4:4 RGB)
Video for Windows™ R210 (10 bit uncompressed 4:4:4 RGB AVI)
Targa Sequential Sequences
Bitmap Sequential Sequences
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Adobe Premiere Pro®

Adobe Premiere Pro® is powerful real-time video and audio non-linear editing 
application. The Blackmagic DeckLink installer will add easy set-ups for 
Premiere Pro®.

Setting Up
Launch Premiere Pro®.

1. Open a New Project.
2. Select the appropriate Blackmagic preset for your project, e.g. NTSC or 

PAL.
3. Type the name of your project.
4. Select your disk array as the location for your media and click “OK.”

Playback
As a quick test to make sure everything is connected correctly, use the 
Blackmagic test media (bars and tone) which can be found on the installer CD. 
Copy a test clip, which matches the format of your project, to your disk array 
e.g. NTSC 8 bit. Import this clip into your Premiere Pro® project and drop it into 
the timeline. You should now see the image on both your computer desktop 
and your DeckLink output. If you can’t see any video on your DeckLink output, 
check the connections again and ensure you have the correct output settings 
configured in both the DeckLink and Displays “control panels.” 

Note: SDI and analog outputs are always active.

Capture
To capture, choose file -> capture. 
Short cut: F5.

To immediately capture, click the red record button [G].
If you wish to log the clip, enter the desired “in” and “out-points” using either the 
“in” and “out” buttons or manually, by typing in the timecode and clicking “log”. 
The empty clip will now appear in the bin window. Repeat this until you have 
logged all of the clips you wish to capture in a batch.

Batch Capture
Select the clips you wish to capture by marque or shift/click. Choose File -> 
Batch capture. To set handles on the clips go to the batch capture window 
menu and type the number of additional frames you require at the top and tail of 
each clip.
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Adobe Premiere Pro®

Audio in Premiere Pro.
DeckLink cards now support ASIO. This means in Premiere Pro that the card is 
seen as an audio device. When you first start your Premiere Pro project, make sure 
you select the audio device you wish to use – either DeckLink audio or a selected 
sound card. This can be done through Edit->Preferences->Audio Hardware. You 
can also select the mix of the multi-channel audio from this menu.

Export to tape
To export to tape, select the sequence you require File->Export->Export to Tape.

Insert editing requires an unbroken timecode over the full length of the program 
you’re laying to tape. This is referred to as ‘blacking the tape’. 

In assemble mode the tape needs only to be ‘blacked’ until a point just beyond 
the start time of the program. As assemble editing erases the tape ahead of 
the record heads, it should not be used where other programs already exist on 
the tape after the out point of your edit.

Premiere Pro™ does not work like a deck. When editing to tape, the software 
waits at the first frame of your program for the deck to drop into record at the 
predetermined timecode. At that exact moment, the program begins to play and 
the edit is completed. Should you find that either the first frame of your program 
is repeated or lost during the edit to tape procedure you will need to adjust the 
playback offset to bring the deck and your computer into sync. You should only 
need to do this once with any combination of deck and computer - and the 
setting will stay correct thereafter.

Now, simply enter the desired in point and offsets if required, and click OK. 

Device Control
Selection of the Serial Device Control is configured via:
Edit->Preferences->Device Control->Options

Protocol:  
Refer to your decks manual for information on what protocols it supports.
Port:  
The DeckLink com port will appear in the list of available communication ports. 
Time Source:  
It is recommended that the VITC and LTC timecode option is selected.
Timebase:  
This setting should be modified only when you are changing formats.  
e.g. PAL is 25 fps change to NTSC 29.976 fps.
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Trouble Shooting
Q: There is no output from my card when in desktop mode.
A: Right click the desktop -> properties -> settings tab. Then left click the 
DeckLink monitor within the “Display Properties” menu and select “extend my 
windows desktop to this monitor”. Click “apply,” then “OK.” You should now 
see your extended desktop on your broadcast monitor.

Q: I can’t get machine control of my tape deck.
A: Make sure that the deck you are using supports and is connected via the 
Sony RS-422 serial protocol. DeckLink does not support older RS-232 serial 
devices. If using a Panasonic deck, you may need to use the deck’s USER 
Menu to change the “ID SEL” to “other”, to make it compatible with the Sony 
RS-422 deck control protocol. “ID SEL” is usually USER Menu item number 
202.

Q: Can I monitor audio from my PC speakers?
A: Yes you can, however we do not recommend it. This is because the PC 
system clock and the DeckLink’s clock are different. If you monitor audio 
through your PC speakers, audio sync for monitoring cannot be guaranteed. 
We recommend using the SPDIF output connectors from the DeckLink PCI 
card.
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If things go wrong
There are three steps to getting help.  

Step 1. Check out the Blackmagic Design web site www.blackmagic-  
 design.com and “click on the support page” for the latest support   
 information.

Step 2. Call your dealer.  
 Your dealer will have the latest technical updates from Blackmagic  
 Design, and should be able to give you immediate assistance.  
 We also recommend you check out the support options your dealer  
 offers as they can arrange various support plans based on your   
 workflow requirements. 

Step 4. The next option is to email us at pcsupport@blackmagic-design.com  
 with your questions. 

Note:  Please provide us with as much information as possible regarding your 
technical problem and system specifications so that we may try to reproduce 
your problem quickly.
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24 Connection Diagrams

DeckLink™
SD-SDI 4:2:2 video and audio, capture and playback card

AES-S/PDIF
Output

Deck Control
RS-422

SD-SDI 4:2:2
Monitoring Output

SD-SDI 4:2:2
Output (to deck)

SD-SDI 4:2:2
Input (from deck)

This DeckLink model does not have genlock, so 
you need to connect your deck to the Deck SDI 
Output, which has stable output to sync the deck. 
Set the deck to input or auto reference. Be sure to 
set the “Black Video Output to Deck in Capture” 
option to “On Digital SDI Outputs” in the DeckLink 
control panel, when using this feature.
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25 Connection Diagrams

DeckLink Pro™
SD-SDI 4:2:2 video and audio capture and playback card with analog monitoring

When you don’t have genlock, you can output 
stable black so DeckLink Pro locks the deck. This 
output is always stable and allows the deck to be 
set to input reference or auto reference. Be sure to 
set the “Black Video Output to Deck in Capture” 
option to “On Digital SDI Outputs” in the DeckLink 
control panel, when using this feature.

R-Y Output
(monitoring)

B-Y Output
(monitoring)

Y Output
(composite monitoring)

SD-SDI Output
(monitoring)

SD-SDI Output
(to deck)

SD-SDI Input
(from deck)

Genlock Input

Deck Control RS-422

DeckLink Pro
7ft Breakout Cable

AES-S/PDIF Output
(monitoring D)

AES-S/PDIF Output
(monitoring C)

AES-S/PDIF Output
(monitoring B)

AES-S/PDIF Output
(monitoring A)



Blackmagic Design - Leading the creative video revolution™

Windows XP™

26 Connection Diagrams

DeckLink SP™
Analog video and audio capture and playback card with SD-SDI 4:2:2 monitoring

When you don’t have genlock, you can output 
stable black so DeckLink SP locks the deck. This 
output is always stable and allows the deck to be 
set to input reference or auto reference. Be sure to 
set the “Black Video Output to Deck in Capture” 
option to “On Analog Outputs” in the DeckLink 
control panel, when using this feature.”

DeckLink SP
7ft Breakout Cable

R-Y Input

B-Y Input

Y Input

R-Y Output

B-Y Output

Y Output
(composite monitoring)

Genlock Input

Deck Control RS-422

SD-SDI Output
(monitoring)

AES-S/PDIF Output
(monitoring)

(L) Audio Input
(balanced analog)

(L) Audio Output
(balanced analog)

(R) Audio Input
(balanced analog)

(R) Audio Output
(balanced analog)
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27 Connection Diagrams

DeckLink Extreme™
SD-SDI 4:2:2 and analog video, audio capture and playback card

Y Input

R-Y Output

B-Y Output

Y Output
(composite monitoring)

SD-SDI Input

SD-SDI Output

Genlock Input

Deck Control RS-422

DeckLink Extreme
7ft Breakout Cable

B-Y Input

R-Y Input

AES-S/PDIF Output
(monitoring)

(L) Audio Input
(balanced analog)

(L) Audio Output
(balanced analog)

(R) Audio Input
(balanced analog)

(R) Audio Output
(balanced analog)

When you don’t have genlock, you can output 
stable black so DeckLink Extreme locks the deck. 
This output is always stable and allows the deck to 
be set to input reference or auto reference. If you 
are using a digital deck, be sure to set the “Black 
Video Output to Deck in Capture” option to “On 
Digital SDI Outputs” in the DeckLink control panel, 
when using this feature. If you are using an analog 
deck, be sure to set the “Black Video Output to 
Deck in Capture” option to “On Analog Outputs”.
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28 Connection Diagrams

DeckLink Extreme™ cable

Genlock In

Deck Control
RS422 

B-Y Out R-Y Out Y Out Y-B In R-Y In Y In Audio
Left

Output

Audio
Right

Output

Audio
Left

Input

Audio
Right
Input

AES-S/PIDF 
Output

10 bit 
SDI Input

10 bit 
SDI Output
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29 Connection Diagrams

DeckLink HD™
HD/SD-SDI 4:2:2 video, audio capture and playback card

AES-S/PDIF
Output

Deck Control
RS-422

HD/SD-SDI 4:2:2
Monitoring Output

HD/SD-SDI 4:2:2
Output (to deck)

HD/SD-SDI 4:2:2
Input (from deck)

This DeckLink HD model does not have genlock, 
so you need to connect your deck to the Deck SDI 
Output which has stable output to sync the deck. 
Set the deck to input or auto reference. Be sure to 
set the “Black Video Output to Deck in Capture” 
option to “On Digital SDI Outputs” in the DeckLink 
control panel, when using this feature.”
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Connection Diagrams

DeckLink HD Plus™
HD/SD-SDI 4:2:2 video, audio capture and playback card

When you don’t have genlock, you can output 
stable black so DeckLink HD Plus locks the deck. 
This output is always stable and allows the deck to 
be set to input reference or auto reference. Be sure 
to set the “Black Video Output to Deck in Capture” 
option to “On Digital SDI Outputs” in the DeckLink 
control panel, when using this feature.

Wordclock
Output

AES-S/PDIF
Output

AES-S/PDIF
Input

Genlock/
Tri-Sync
REF Input

Deck
Control
RS-422

HD/SD-SDI 4:2:2
Output (to deck)

HD/SD-SDI 4:2:2
Input (from deck)

DeckLink HD Plus
Break-out Cable
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31 Connection Diagrams

DeckLink HD Pro™
HD/SD-SDI 4:4:4/4:2:2 video, audio capture and playback card with analog monitoring
(Dual Link Mode 4:4:4)

When you don’t have genlock, you can output 
stable black, so DeckLink HD Pro locks the deck. 
This output is always stable and allows the deck to 
be set to input reference or auto reference. Be sure 
to set the “Black Video Output to Deck in Capture” 
option to “On Digital SDI Outputs” in the DeckLink 
control panel, when using this feature.

Wordclock
Output

AES-S/PDIF
Output

AES-S/PDIF
Input

R-Y/R
Output

B-Y/B
Output

Y/G
Output

Genlock/
Tri-Sync
REF Input

Deck
Control
RS-422

HD/SD-SDI 4:2:2
Monitoring Output

HD/SD-SDI 4:2:2
Output (to deck)

HD-SDI Input
4:4:4 Ch 2

HD/SD-SDI 4:2:2
Input (from deck)

DeckLink HD Pro
Break-out Cable

Dual Link HD-SDI 4:4:4
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32 Connection Diagrams

DeckLink HD Pro™
HD/SD-SDI 4:4:4/4:2:2 video, audio capture and playback card with analog monitoring
(Single Link Mode 4:2:2)

When you don’t have genlock, you can output 
stable black so DeckLink HD Pro locks the deck. 
This output is always stable and allows the deck to 
be set to input reference or auto reference. Be sure 
to set the “Black Video Output to Deck in Capture” 
option to “On Digital SDI Outputs” in the DeckLink 
control panel, when using this feature.

Wordclock
Output

AES-S/PDIF
Output

AES-S/PDIF
Input

R-Y/R
Output

B-Y/B
Output

Y/G
Output

Genlock/
Tri-Sync
REF Input

Deck
Control
RS-422

HD/SD-SDI 4:2:2
Monitoring Output

HD/SD-SDI 4:2:2
Output (to deck)

BNC for Dual Link only

HD/SD-SDI 4:2:2
Input (from deck)

DeckLink HD Pro
Break-out Cable

HD/SD-SDI 4:2:2 Mode
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33 Connection Diagrams

DeckLink HD Pro™ (Single Link card)
HD/SD-SDI 4:2:2 video, audio capture and playback card with analog monitoring

When you don’t have genlock, you can output 
stable black so DeckLink HD Pro locks the deck. 
This output is always stable and allows the deck to 
be set to input reference or auto reference. Be sure 
to set the “Black Video Output to Deck in Capture” 
option to “On Digital SDI Outputs” in the DeckLink 
control panel, when using this feature.

Wordclock
Output

AES-S/PDIF
Output

AES-S/PDIF
Input

R-Y/R
Output

B-Y/B
Output

Y/G
Output

Genlock/
Tri-Sync
REF Input

Deck
Control
RS-422

HD/SD-SDI 4:2:2
Output (to deck)

HD/SD-SDI 4:2:2
Input (from deck)

DeckLink HD Pro
Break-out Cable

HD/SD-SDI 4:2:2 Only
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34 Connection Diagrams

DeckLink HD Pro™ cable

Wordclock 
Output

AES-S/PDIF
Output

AES-S/PDIF
Input

REF 
Input

B-Y/B 
Output

Y/G
Output

R-Y/R 
Output

Deck Control

DeckLink HD Pro
Connection
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Blackmagic Design Limited Warranty
Blackmagic Design warrants that this product will be free from defects in materials and workmanship for a period of 12 months from the date 
of purchase. If a product proves to be defective during this warranty  period, Blackmagic Design, at its option, either will repair the defective 
product without charge for parts and labor, or will provide a replacement in exchange for the defective product. 

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the defect before the expiration of the war-
ranty period and make suitable arrangements for the performance of service. The Customer shall be responsible for packaging and shipping the 
defective product to a designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer shall be respon-
sible for paying all shipping changes, insurance, duties, taxes, and any other charges for products returned to us for any reason. 

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care. Black-
magic Design shall not be obligated to furnish service under this warranty: a) to repair damage resulting from attempts by personal other than 
Blackmagic Design representatives to install, repair or service the product, b) to repair damage resulting from improper use or connection to 
incompatible equipment, c) to repair any damage or malfunction caused by the use of non Blackmagic Design parts or supplies, or d) to service 
a product that has been modified or integrated with other products when the effect of such a modification or integration increases the time or 
difficulty of servicing the product. THIS WARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF ANY OTHER WARRANTIES, EXPRESS 
OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 
A PARTICULAR  PURPOSE. BLACKMAGIC DESIGN’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE WHOLE 
AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
IRRESPECTIVE OF WETHER BLACKMAGIC DESIGN OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH  DAMAGES. 
BLACKMAGIC DESIGN IS NOT LIABLE FOR ANY ILLEGAL USE OF EQUIPMENT BY CUSTOMER. BLACKMAGIC IS NOT LIABLE FOR ANY 
DAMAGES RESULTING FROM USE OF THIS  PRODUCT. USER OPERATES THIS PRODUCT AT OWN RISK. 

Copyright 2004 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DeckLink’, ‘HDLink’, ‘DeclLink Multibridge’ ‘Workgroup 
Videohub’ and ‘Leading the creative video revolution’ are registered trademarks in the US and other countries. All other company and product 
names may be trade marks of their respective companies with which they are associated.
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